BONUS CHAPTER 3

Site and Topography

When it comes fo adding a site to a model, the Autodesk® Revit® Architecture
software is well equipped to take on the challenge. However, in many cases
Revit is dependent on Autodesk® AutoCAD® or MicroStation to provide a
real-case scenario for a site that can be imported (similar to importing a plan
or a detail). Fortunately, Revit provides tools to add a topographic surface to an
imported CAD site.

This chapter covers the following topics:

Adding a site in Revit

Splitting the surface

Creating subregions

Adding site components

Adding building pads to displace earth
Adding a property line

Creating a toposurface by instance

Creating a graded region

Adding a Site in Revit

To get started, let’s do something easy and then migrate into the more
difficult areas, such as importing a CAD file. The first item you’ll tackle
will be to start a site using datum points that you’ll manually pick using
the Toposurface function on the Ribbon’s Massing & Site tab.

)% N O TE Metricusers should not type in mm or other metric abbreviations
% when entering amounts suggested in the exercises. Revit will not accept such abbre-
viations. Simply enter the number provided within the parentheses.
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Let’s get cracking. First, open the model you've been using to follow along. If
you missed the previous chapter, go to the book’s web page at www.sybex.com/
go/revit2017ner. From there, you can browse to the Chapter BC3 folder and
find the NER-BC3 rvt file.

The objective of this procedure is to add a topographical surface by choosing
datum points and elevations. Follow these steps:

1. In the Project Browser, find the Site floor plan and open it.
2. Type VG for Visibility Graphics.

3. On the Annotation Categories tab, deselect Callouts, Elevations,
Grids, Matchline, Stairs, and Sections, and click OK.

4. On the Massing & Site tab, click the Toposurface button, as shown in
Figure BC3.1.
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FIGURE BC3.1: ClicktheToposurface button on the Massing & Site tab of the
Ribbon.

5. On the Options bar, set the elevation to -2'—6” (-750 mm) (that’s
negative 2—6” [negative 750 mm]).

6. Pick points in a pattern to the right half of the building, as shown in
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FIGURE BC3.2: Addingthefirst contours




Adding a Site in Revit

N O T E  Notice that after you click the Toposurface button, Revit launches Sketch
Mode. The Place Point button is selected by default in Toposurface Sketch Mode.

7. With the Place Point command still running, set Elevation on the

10.

11.
12.

13.
14.

Options bar to -1'-0” (-300 mm).

. Pick five or six points in a line, similar to Figure BC3.3.

T

FIGURE BC3.3: Addingthesecond contour to the site

With the Place Point command still running, set Elevation on the
Options bar to 2’ (600 mm).

Add a third contour line to the left of the second, as shown in
Figure BC3.4.

Click Finish Surface (the green check mark).

Select the topographical surface; then, in the Properties dialog box,
click into the Material field, and click the [...] button.

At the top of the Material Browser, enter the word grass.

When the Grass material appears in the search results window, select
it as shown in Figure BC3.5.
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FIGURE BC3.4: Addingthe thirdset of contours
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FIGURE BC3.5: Findingsome grass

15. Select the Graphics tab, and change Cut Pattern to Earth.
16. Click OK.

17. Go to a 3D view, and check out your site.

Next let’s see how you can modify a site after you create it. You'll have to deal
with the fact that the ramps at the east entry are now buried in your site.
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Modifying a Toposurface

Because you must always make modifications to a toposurface, you need to learn
how to do so. The method is basic. Select the site, click Edit, and away you go!

In this procedure, you’ll modify the toposurface to allow for the ramps to land
on earth. Follow these steps:

1.
2.
3.

v ® NS VA

10.
11.
12.

Go back to the Site plan.
Set Visual Style to Wireframe.

Zoom in on the west wing area where the slanted curtain wall
resides, as shown in Figure BC3.6.
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FIGURE BC3.6: Addingthe0elevation points

Select the site (you may have to find an edge).

On the Modify | Topography tab, click Edit Surface.
On the Tools panel, click the Place Point button.
On the Options bar, set Elevation to 0.

Pick five points (see Figure BC3.6).

Click Finish Surface on the Surface panel.

Change Visual Style to Realistic.

Go to a 3D view to make sure it looks correct.

Save the model.
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Excellent! You're getting the hang of this. Next, you need to create some
raised areas (small hills) where you can eventually add plantings and differ-
ent materials. The problem is, to create a small hill, you need the site to rise
sharply to the new elevation. To achieve this, you have to split the surface
physically.

Splitting the Surface

When you need to make a drastic change to the surface’s elevation without
influencing the rest of the site, you must split the surface. Just to warn you up
front—Dbe deliberate about when and where you do this, because you're physi-
cally cutting a hole in the surface and adding a secondary toposurface to the
void. Although you can merge these surfaces back together, in some situations
it can be difficult to merge cleanly.

Let’s split the toposurface and create smaller toposurfaces. Follow these
steps:

1. In the Project Browser, go back to the Site plan.

2. On the Massing & Site tab, click the Split Surface button, as shown in
Figure BC3.17.

3. Select the toposurface.

4. Zoom in on the corridor area that links the east and west wings.

Massing & Site
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Splits a toposurface into 2 distinct surfaces, so that each can be
edited independently.

Press F1 for more help

FIGURE BC3.7: Thesplitsurface button

5. On the Draw panel, click the Start-End-Radius Arc button. On the
Options bar, click the Chain toggle on.



Splitting the Surface 7

6. Sketch a perimeter similar to the one in Figure BC3.8.
7. Click Finish Edit Mode. You have a new toposurface.

You can manipulate this surface without influencing the main topography.
This is the ideal situation for creating bumps and berms.

Next you'll raise this toposurface to an elevation of 4’ (1200 mm). You do
this by using a point and placing the datum in the middle of the berm. Follow
these steps:

1. Select the newly formed toposurface, as shown in Figure BC3.8.

After you place the
points in the model,
FIGURE BC3.8: Addinganewdatum elevation you can still pick the
points and drag them
left and right as well

. . . as up and down. Also,
2. Click the Edit Surface button on the Modify | Topography tab. D e ado

3. On the Tools panel, click the Place Point button. in section or elevation,
you can pick the points

4. On the Options bar, enter a value of 4'—0” (1200 mm) in the Elevation and drag them up and
field. down, too.

5. Pick four points near the center of the hill (see Figure BC3.9). K

6. Click Finish Surface.

7. Select the split surface again.

8. In the Properties dialog box, change the material to Earth.
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FIGURE BC3.9: Thesplitsurface sketch

9. Deselect the topography. Your site should resemble Figure BC3.10.

FIGURE BC3.10: Theraisedarea of the site

- N O T E Yes, you can copy these little hills just like anything else in Revit—I'm
% glad you asked! After you copy the hills, you can edit them like any other toposurface.



Creating Subregions

Well, I think you can see where this is going. When you work with sites, it’s
good to have some kind of procedure. This takes you to the next perplexing situ-
ation. Suppose you want to keep the contours and the dips and hills intact, and
you only want to specify a new material in a subregion of the main topography.
Is this possible? Yes, it is!

Creating Subregions

The purpose of a subregion is to match two surface materials so that any
change in elevation or lateral movement is reflected in both regions. You need
this ability for walks and most roadways. When you divide the toposurface into
subregions, you give yourself the freedom to manipulate two different materials
in the same datum. Another benefit of subregions is that the file size remains as
if there were still one toposurface. If you were to split the surface every time you
needed a path or a roadway, your file size would bloat.

In the following procedure, you'll create a walkway path using the Subregion
command. Follow these steps:

1. Go to the Site plan.
2. Zoom in on the east entry.

3. On the Massing & Site tab, click the Subregion button as shown in
Figure BC3.11.
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FIGURE BC3.11: TheSubregionButton

4. Change the view to Wireframe, and start sketching away.

5. Draw a region similar to the one shown in Figure BC3.12. (It doesn’t
have to be exact.) This image shows a parking area with some pedestrian
access. The inside of the parking area follows the building footprint. Pick
Finish Edit Mode.
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FIGURE BC3.12: Sketchingthesubregion

6. In the Material row in the Properties dialog box, change the material
to Brick, Pavers from the AEC Materials list in the lower panels.

7. Change the view back to Realistic.
8. Go to a 3D view, and compare yours with Figure BC3.13.

FIGURE BC3.13: Thesidewalksin3D

N O T E Youcan't cross over and exceed the extents of the original boundary.
If you do, Revit won’t allow you to finish the sketch. Also, this subregion must form a
continuous loop with no gaps or overlapping lines. You need a straight line at each end
of the path.



Adding Site Components

How did you do? If you aren’t happy with your parking lot layout, go back and
redo it. Not too shabby! There is definitely something missing from this parking
lot, though. Perhaps some actual parking spaces would be nice. And a parking
island or two would make the parking lot stand out.

Adding Site Components

Adding a site component to Revit is no different than adding a desk or a door.
A component is a component, as far as Revit is concerned. As you've learned, a
component is hosted by a system component. For example, when you're inserting
a window, there needs to be a wall, or Revit won’t allow such a foolish transaction
to occur. In Revit, you can host a site component to a level, but it’s a bad idea to
do so. When you add a site component, you always want to host that component
to the actual topography.

In this procedure, you'll add parking components and plantings to the Revit
model. Follow these steps:

1. On the Insert tab, click the Load Family button.
2. Scroll to the Parking directory in the Site folder.

3. Load every file in the directory. If you get a Family Already Exists
message about Parking Space, click Overwrite The Existing
Version.

4. In the Project Browser, go to the Site plan.
5. In the View Control bar, set Visual Style to Realistic.

6. On the Massing & Site tab, click the Site Component button, as
shown in Figure BC3.14.
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Adds site-specific elements, such as trees, parking islands, and fire
hydrants.

Press F1 for more help

FIGURE BC3.14: TheSite Componentbutton

11
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7.

8.

9.

10.
11.
12.
13.

14.

In the Type Selector, select Parking Island — Single Sided 15 Spaces
per row.

In the Properties dialog box, change Parking Width to 138"-8”
(41600 mm).

Place the parking island in a location similar to that shown in
Figure BC3.15. Note that you’'ll have to press the spacebar to orient
the component correctly. Click Modify.

FIGURE BC3.15: Addingthe component to the parking lot

Select the parking component.
Click the Edit Family button on the Modify | Site tab.
Select both the curb and the grass extrusions.

In the Properties dialog box, click the Edit button in the Visibility/
Graphics Overrides row.

In the Display In 3D Views menu, select all four items.



Adding Site Components

15. Click OK.

16. Click the Load Into Project button. Click Overwrite The Existing
Version if prompted to do so. Your model should resemble
Figure BC3.13.

Now that the island is in place, it’s time to add the parking spots. You'll need
an ADA (parking for disabled drivers, required by the Americans with Disabilities
Act) space as well as some general parking spaces. Follow these steps:

1. On the Massing & Site tab, click the Parking Component button.

2. Select Parking Space — ADA 9’ x 18’ (5" Aisle) (2743 mm x 5486 mm).
Place an instance as shown in Figure BC3.16. Use the spacebar to
rotate it properly.

FIGURE BC3.16: TheADAparkingspace

3. Click the Site Component button.
4. Add Parking Symbol — ADA, and place it as shown in Figure BC3.14.

5. Mirror the ADA space and the ADA symbol to the north of the park-
ing island, as shown in Figure BC3.17.

13
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FIGURE BC3.17: Theparking spaces

6. Add a parking space 9" x 18" — 90 deg (2743 mm x 5486 mm), and

copy it up to fill the island with parking (see Figure BC3.17).

The parking lot is somewhat complete, so let’s add some trees and shrubs to
the site. This will be a lot easier! Follow these steps:

1.
2.
3.

On the Insert tab, click the Load Family button.
Browse to the Planting folder.

Select everything available, and load it into the model. Overwrite any
existing versions.

On the Massing & Site tab, click the Site Component button.

. Place trees and shrubs on the parking island and on the berm you

created. Notice that the plantings always follow the grade of your site.
Be creative.



Adding Site Components

6. Go to a 3D view and check it out, as shown in Figure BC3.18.

FIGURE BC3.18: Addingthe plantings

With all the contours and plantings in place, you need to knock out a small
maintenance issue. There is a function that will allow you to add contour labels
to the site automatically; this is a great feature in Revit Architecture.

Adding Contour Properties and Labels

Because nothing in Revit Architecture is dumb, you can take advantage of a
topographic surface having some smarts as well. Even the contour lines of a
site are smart.

The objective of this procedure is to examine some site settings and
throw some labels into the contours. It’s a quick set of steps but important
nonetheless.

1. Click the arrow in the lower-right corner of the Model Site panel, as
shown in Figure BC3.19.

2. In the Site Settings dialog box that opens is a field that contains
additional contours. In the Increment panel, change the value 1" -0”
(300 mm) to 6” (150 mm) (see Figure BC3.19).

3. Click OK. Notice that the contours are tighter.

15
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FIGURE BC3.19: Changing the additional contourincrement

Now that the contours are in place, you can label them. Luckily, a func-
tion in Revit allows you to do this in one shot. All you need to do is draw a
line specifying the alignment of the contours, and Revit will add the labels
automatically.

Follow these steps to add contour labels to the site:

1. On the Massing & Site tab, click the Label Contours button, as shown
in Figure BC3.20.

2. Pick a point to the outside of the toposurface, labeled 1 in
Figure BC3.18.

3. Pick a second point near the building, labeled 2 in Figure BC3.18.
After you pick the second point, the contours are labeled.

Next, you need to address a situation that has arisen unbeknownst to you.
You see, you never defined any areas into which you may not want earth to spill,
such as the basement. This will affect every section you have. You can place a
pad to displace the earth in the basement.



Adding Building Pads to Displace Earth
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FIGURE BC3.20: Labelingthe contours

Adding Building Pads to Displace Earth

When you need to displace a volume of earth, you use a tool exclusive to the Massing
& Site tab to do so. By placing a building pad into your model, you tell Revit that you
want to cut the earth away from this area while still leaving the earth beneath at a
certain elevation. For example, if you want to remove the earth from the basement
(which you’ll be doing) but you still need the earth to exist beneath the basement,
you must place a building pad.

To place a building pad into the model, follow this procedure:

1. In the Project Browser, go to the T.O. Footing plan.

2. On the Massing & Site tab, click the Building Pad button, as shown in
Figure BC3.21.

Massing & Site
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s
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Adds a building pad from a closed loop that you sketch on a
toposurface.

Press F1 for more help

FIGURE BC3.21: TheBuilding Pad button

17
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10.

11.
12.

13.

14.
15.
16.

17.

® ® N & 0 A

In the Properties dialog box, make sure Pads is current, and click
Edit Type.

Click Duplicate.

Call the pad Footprint, and click OK.

For the Structure, click the Edit button.

Change Thickness to 6” (150 mm).

Click OK twice.

Change Height Offset from Level to 6” (150 mm).

Set Offset to 1”7 (25 mm) on the Options bar, and pick walls to place the
pad against the outside of the foundation wall underneath the entire
model, as shown in Figure BC3.22. Trim the sketch lines as necessary.
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FIGURE BC3.22: Placethepad1” (25 mm) to the outside of the wall.

Click Finish Edit Mode.

In the Project Browser, open West Corridor Section. You may have to
adjust the crop region to see the footings.

You can see the pad sitting on top of the footing extending past the
wall, as shown in Figure BC3.23. Select it.

Right-click, and select Hide In View > Elements (see Figure BC3.23).
Go to the Model Site panel, and click the Site Settings arrow.

In the Section Graphics area, change the Elevation Of Poche Base
value to -15'-=0” (-4500 mm).

Click OK. The earth hatch is now beneath the slab area.



Adding a Property Line
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FIGURE BC3.23: Hidingthepadintheview

With the pad in place, you can rest assured that your sections are showing the
earth where it’s supposed to be.

The next item I'll cover is creating a property line. In most conventional draft-
ing applications, this involves nothing more than adding a polyline around the
site. In Revit, this approach is the same, but the property line can tell you much
more about the boundary it’s encasing.

Adding a Property Line

If you want to add a property line, Revit provides the tool you need. Of course,
this is Revit, so you aren’t just adding a dumb line to the model. When you start
the Property Line command, Revit will ask if you want to create the property
line either by using bearing distances or by sketching (a sketch can be converted
to a bearing table after it has been placed).

To add a property line, follow this procedure:

1. In the Project Browser, go to the Site floor plan.

2. On the Massing & Site tab, click the Property Line button, as shown
in Figure BC3.24.

3. In the Create Property Line dialog box that appears, click the Create
By Sketching option.

4. Draw a series of lines around the perimeter (see Figure BC3.24).
Close the sketch by returning to the starting point, but note that you
don’t have to close a property line.

19
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9.

Massing & Site
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Press F1 for more help

FIGURE BC3.24: Addingapropertyline

5. Click Finish Edit Mode.
6.
7
8

Select the property line.

. On the Modify | Property Lines panel, click the Edit Table button.

. Click Yes if you get a “Do you want to continue?” dialog box.

Close the Property Lines dialog box, and save the model.

You now have a table of deed data that can be modified as you see fit. If your
property line is open, there is an option in the table to create a line to close it so
that you can calculate area.

The next item on the agenda is a powerful tool when it comes to creating a
site in Revit. As nice as it would be never to depend on CAD, most of your topo-
graphical information will come from the CAD world. Revit has a By Instance
function that can facilitate this procedure.

Creating a Toposurface by Instance

Creating a toposurface by instance requires that you import a CAD file. After
you do so, you can go to the Toposurface command, which offers the choice to
use an imported instance to drape a surface from Revit.



Creating a Toposurface by Instance

To get started, either you can choose a site that was created in CAD and with
which you want to experiment or you can go to the book’s web page at www.
sybex.com/go/revit2017ner. From there, you can browse to the Chapter BC3
folder and find the contours.dwg file.

The first thing you need to do is think about coordinates. That’s right: coor-
dinates. You're bringing in a file from AutoCAD, right? How do you know where
this site will be placed? You must consider two things: where the project base
point is in AutoCAD and where the survey point is located. When you know
these two things, you can work more logically between AutoCAD and Revit. The
next set of procedures will show you how to coordinate your Revit site with an
AutoCAD site:

1. Start a new Revit model.
2. Go to the Site plan.

3. Notice the two blue icons in the model. Pick a window around them,
and click the Filter button.

4. Deselect Project Base Point, as shown in Figure BC3.25.
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FIGURE BC3.25: Selectingthe project datum

5. Click OK.
6. Deselect the blue paper clip, as shown in Figure BC3.26.

21
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FIGURE BC3.26: Alteringthesurvey point

7. Change N/S to 200" (60000 mm).
8. Change E/W to 200" (60000 mm).

WHAT ARE YOU CHANGING, AND WHY?

What you're changing here is a survey point. You don’t know the survey point of
the practice file you're bringing into the model, so for now you're making one
up. The project base point always wants to be 0,0.

9. Click the Survey Point — Internal link (see Figure BC3.24).

10. In the Location Weather And Site dialog box that opens, on the Site
tab, click the Duplicate button.

11. Call the new location Site Datum. Click OK.
12. Click the Location tab.

13. Using the Internet Mapping Service, set the location for Syracuse, NY
USA (see Figure BC3.27). You can also use your own location.



Creating a Toposurface by Instance

Location Weathe
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FIGURE BC3.27: Settingthesite

14. Click OK.
15. Press Esc.

Now you'll set the project orientation. In Revit, you can rotate the site plan to
true north while leaving the other views oriented to project north. Let’s do it:

1. In the Properties dialog box for the view, change Orientation to True
North, as shown in Figure BC3.28.

roperties (=)
Floor Plan -
Floor Plan: Site ~ | B8 Edit Type
Graphics A
View Scale 1"=200" F
Scale Value 1: 1280
Display Model Normal
Detail Level * Coarse -
Parts Visibility " Show Original F
Visibility/Graphics Ov... {___ Edit.____]
Graphic Display Options. Edit...
Underlay None
Underlay Orientation | Plan
Orientati [TrueNorth N
Wall Join Display Clean all wall jéths
Discipline " Architectural
Color Scheme Location | Background
Color Scheme . <none> ]
Default Analysis Displ... | None
Sun Path .[]
Identity Data Bl
[T cu.
Prop help Apply

FIGURE BC3.28: Orientingthesite to true north
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2. On the Manage tab, click Position > Rotate True North, as shown in
Figure BC3.29.
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]ﬁ Rotate True Nonh
; g Mimor Project
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FIGURE BC3.29: Rotatingtruenorth

3. Pick the node on the Survey point, as shown in Figure BC3.30.

FIGURE BC3.30: Finalizing therotation

4. Pick a second point at 45° left (which lands you straight up—see
Figure BC3.28). Your site view is now facing true north, and all your
other views are project north.



Creating a Toposurface by Instance

Next, you'll import a site from CAD. To use an imported instance to create a

toposurface, follow these steps:

1. Save your model as Imported Site.rvt.

. In the Project Browser, go to the Site plan if you aren’t there already.

2
3. On the Insert tab, click the Link CAD button.
4

. Browse to the contours.dwg file you downloaded. (If you have your

own site DWG file, that’s fine, too.)

5. Before you click Open, change Colors to Black And White, Layers to
All, and Import Units to Feet. Also, change Positioning to Auto — By
Shared Coordinates. Be sure Current View Only is deselected.

6. Make sure Orient To View is selected. (See Figure BC3.31.)

B Link CAD Formats
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FIGURE BC3.31: Changing the link settings

7. Click Open.

8. The Differing Coordinate Systems For Project And File dialog box

opens. Click Close.
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9.

Click the existing coordinate choice, and click OK.
Your site should be positioned as shown in Figure BC3.32.

QA /

FIGURE BC3.32: Thelinkedsite

Because you didn’t know the actual survey point of your site, AutoCAD gave
you one. It’s obviously off the grid. You can move the site to a specific point
and create an actual survey point in the native AutoCAD file. Follow these

steps:

LA A

Select the imported site.

Click the Move button.

Move the site to a position similar to that shown in Figure BC3.33.
Save the file. A dialog box opens, asking about your shared position.

Click Save. Doing so adds a new position in the site DWG file. You're
now coordinated with your site people. (See Figure BC3.31.)



Creating a Toposurface by Instance

Location Position Changed

You have changed the “current” Position in contours.dwg. What do you
want to do?

* save
Soves the ngg poston backtothe ke e

# Donotsave

 Disable shared positioning

FIGURE BC3.33: Saving the shared position back to the drawing

It’s time to add a Revit surface to the contours. This is pretty easy; follow
these steps:

1. On the Massing & Site tab, click the Toposurface button.

2. On the Tools panel, click Create From Import > Select Import
Instance, as shown in Figure BC3.34.

& &85 5
Create |Simplify | Set Show Ref Viewer
int | from Import | Surface Plane
@—| Work Plane
|

Specify Point{ . rect Import Instance

Creates a toposurface based on 3D contour data imported in
DWG, DXF, or DGN formats.

Create Surface

Press F1 for more help

FIGURE BC3.34: Adding thetoposurface
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3. Select the imported CAD file.

»

Deselect Layer 0 and Defpoints in the Add Points From Selected
Layers dialog box.

Click OK.

In the Properties dialog box, change Material to Grass.
Click OK to get back to the model.

Click Finish Surface.

o ® N & W

Go to a 3D view. Your topography should look like Figure BC3.35.

FIGURE BC3.35: Thenew toposurface inRevit

That would be a difficult toposurface to create entirely in Revit! The next item
you need to explore is how to grade a surface, yielding areas of cuts and fills. The
process is straightforward, but as you're about to learn, you need to first deal
with project phasing.

Creating a Graded Region

This section of the chapter will focus on creating cuts and fills in a site. You

do this by lowering and raising points that already exist in the topography.
The problem is, after you alter the site, you don’t know which part of the site is
original or existing and which part is new.



Creating a Graded Region

The objective of the following procedure is to move the site to an existing
phase to prepare it for the grading process. Follow these steps:

1.
2.

10.
11.
12.
13.

14.

N S v AW

Go to your Site plan, and type VG.

In the Visibility/Graphics Overrides dialog box, click the Imported
Categories tab.

Deselect contours.dwg.

Click OK.

Select the toposurface.

In the Properties dialog box, change Phase Created to Existing.

On the Massing & Site tab, click the Graded Region button, as shown
in Figure BC3.36.

Massing & Site

98 B 4 [l O & 2

Wall Floor | Toposurface  Site Parking  Building | Split Subregion Graded
Component Component  Pad | Surface

Region|
Face Model Site M Modify Site L3 _

FIGURE BC3.36: GradedRegion

In the next dialog box, click Create A New Toposurface Exactly Like
The Existing One.

Draw a selection window around the center of the site (doing so
selects a bunch of points), as shown in Figure BC3.37.

In the Properties dialog box, enter a value of 0 for the elevation.
Click Finish Surface.
Verify that your site appears similar to Figure BC3.38.

Select the newly graded surface, and notice in the properties that you
can get the volumes for Net Cut/Fill.

Save the model, and close it.
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N—
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W

FIGURE BC3.38: Thesitewithcutsandfills

That’s quite a bit of information regarding sites. It’s nice that Revit allows
some level of site manipulation, but it would be handy if there were a Revit Site
application. I, for one, could see the value in that.



Are You Experienced?

Are You Experienced?
Now you can...

v’ add a topographical surface to your site by using points

v/ create a topographical surface in your site by using an imported
CAD file

v/ add site components
v split and divide a site’s topography
v rotate a project to true north

v relocate a project’s datum elevation
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